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Course Content  
  

Theory:  Introduction to Computers, Operating Systems, definition and types, Applications of MS-Office 

for document creation & Editing, Data presentation, interpretation and graph creation, statistical analysis, 

mathematical expressions, Database, concepts and types, uses of DBMS in Agriculture, World Wide Web 

(WWW): Concepts and components. Introduction to computer programming languages, concepts and 

standard input/output operations. e-Agriculture, concepts and applications, Use of ICT in Agriculture. 

Computer Models for understanding plant processes. IT application for computation of water and nutrient 

requirement of crops, Computer-controlled devices (automated systems) for Agri-input management, 

Smartphone Apps in Agriculture for farm advises, market price, postharvest management etc; Geospatial 

technology for generating valuable agri-information. Decision support systems, concepts, components and 

applications in Agriculture, Agriculture Expert System, Soil Information Systems etc for supporting Farm 

decisions. Preparation of contingent crop-planning using IT tools.  

  

Practical  

Study of Computer Components, accessories, practice of important DOS Commands. Introduction of different 

operating systems such as windows, Unix/ Linux, Creating, Files & Folders, File Management. Use of MS-

WORD and MS Power-point for creating, editing and presenting a scientific Document. MSEXCEL - Creating 

a spreadsheet, use of statistical tools, writing expressions, creating graphs, analysis of scientific data. MS-

ACCESS: Creating Database, preparing queries and reports, demonstration of Agriinformation system. 

Introduction to World Wide Web (WWW). Introduction of programming languages. Hands on Crop 

Simulation Models (CSM) such as DSSAT/Crop-Info/CropSyst/ Wofost; Computation of water and nutrient 

requirements of crop using CSM and IT tools. Introduction of Geospatial Technology for generating valuable 

information for Agriculture. Hands on Decision Support System. Preparation of contingent crop planning.   
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Introduction   

 
The word Computer has been derived from the word “Compute” which means to calculate. A computer 

is an electronic device or machine which performs calculations and controls operations that can be 

expressed either in logical or numerical terms. Or, A computer is an electronic device which performs 

arithmetical and logical operations.   

Data:     It is raw material used as Input to data processing.  

Information:   It is processed data obtained as output.  

Characteristic:         Speed, Accuracy, Diligence, Versatility, Storage Capability, No I.Q. No feeling Speed  

The computer processes the data at an extremely fast rate. The speed of the computer is measured in MHz 

i.e. one million instructions per second.  

    10-5  -  Milliseconds  

10-6  -  Microsecond  

    10-9  -  Nanosecond  

    10-12  -  Picoseconds  

Accuracy  

Besides efficiency (being fast), the computers are very accurate. The level of accuracy depends on the 

instructions and its design. The computer is capable of doing only what it is instructed to do. Faulty 

instructions for processing the data lead to faulty results. This is called “Garbage In and Garbage Out” 

i.e.  

GIGO  

Diligence  

Computer being a machine, it does not suffer from tiredness and lack of concentration. If 5 million 

calculations are to be performed, the computer performs the last one with the same speed and accuracy 

as the first one. Versatility  

Computers are versatile in nature. i.e. the Computers can perform multiple tasks simultaneously with 

equal ease.  

For example, at one moment it can be used to prepare letters and in other moment it can print the 

document and in between it can be used to play music.  

Reliability  

It is the measurement of performance of a computer which is measured against pre-determined standard 

for operation without any failure i.e. at Hardware level, it does not require any human intervention 

between its processing operations. Storage Capability  

Computer can store large amounts of data and it can recall the required information almost 

instantaneously because of its secondary storage like magnetic disk (CD ROM) or Hard Disk. No I.Q. 

and No Feelings  

Being a machine the computer has no intelligence of its own. It does not have ability to think. It can not 

take its own decision. it has no feelings.  

The computer is an electronic machine that performs the following four general operations:  

• Input  

• Storage  

• Processing   Output.  
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Input  
The input hardware allows you to enter data into the computer. The primary devices used are the keyboard 

and mouse.  

Keyboard - The keyboard looks like the typewriter. A numeric keypad is located to the right of the 

keyboard. Numeric keys have the same placement as a 10-key calculator, which allow the operator to 

enter data rapidly.  

Mouse - The mouse is a device that allows you to control the movement of the insertion point on the 

screen. The operator places the palm of the hand over the mouse and moves it across a mouse pad, which 

provides traction for the rolling ball inside the device. Movement of the ball determines the location of 

the I beam on the computer screen. When the operator clicks the mouse the I beam becomes an insertion 

point which indicates the area you are working on the screen. You can also click the mouse and activate 

icons or drag to move objects and select text. There are other input devices, such as touch screen, joystick, 

modem, scanner, and voice recognition systems.  

Processing  
The central processing unit or (CPU) is the "brain" of your computer. It contains the electronic circuits 

that cause the computer to follow instructions from ROM (read only memory) or from a program in RAM 

(random access memory). By following these instructions information is processed. The CPU contains 

three parts.  

1. Arithmetic Logic Unit - ALU is where the "intelligence" of the computer is located. It can 

add and compare numbers. To multiply 2 x 4 the computer would add 2 + 2 + 2 + 2. The ALU 

makes decisions by determining if a number is greater, less, or equal to the other number. 

Processing is completed in nanoseconds, which is a billionth of a second.  

2. Memory - Two types of memory contained on a chip are RAM (Random Access Memory) 

or ROM (Read Only Memory). ROM memory has been installed on your computer by the 

manufacturer and can not be altered. ROM is the memory that determines all the basic functions 

of the operation of your machine, such as startup, shut down, and placing a character on the screen. 

RAM is temporary memory, which displays the information you are working on. RAM 

remembers what you see on your screen while you are working. Today's applications required 

large amounts of temporary memory, which may require you to upgrade and add more RAM 

memory.  

3. Control Unit - This is the part of the unit, which directs information to the proper places 

in your computer, such as calculation of information by the ALU unit or to store and print material.  

Output  
Output devices such as a monitor or printer make information you input available for you to view or use.  

A monitor's front is called a screen with a cathode ray tube (CRT) attached to the screen. Portable 

computers use a (LCD) liquid crystal display. Today's super video graphics array (SVGA) monitors 

display 256 sharp and clear colors.  

Printers used with computers fall into two categories, impact or nonimpact. Impact printers, such as dot 

matrix print by contact against a ribbon making imprint on paper. Inkjet printers print images by not 

touching the paper. Ink jet printers spray ink onto the page while a laser printer works like a copying 
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machine. Laser printers print a higher quality product but cost from Rs. 8000 to Rs 50,000 whereas an 

ink jet produces better quality than a dot matrix and can be purchased from Rs1500 to Rs`5000. The 

personal computer user most commonly purchases an ink jet printer for home use.  

Storage  
Auxiliary storage devices, also called secondary storage devices, are used to store instructions and data 

when they are not being used in memory. Two types of auxiliary storage more often used on personal 

computers are floppy disks and hard disks. Also, CD-ROM drives are common.  

Floppy Disks - A floppy disk is a circular piece of oxide-coated plastic that stores data as magnetic spots. 

Personal computers most commonly use floppy disks that are 3  inches in diameter.  

To read data stored one floppy disk or to store data on a floppy disk, you insert the floppy disk in a disk 

drive. If the disk is unused, you must format or initialize it before your computer will allow you to store 

data on it. Formatting organizes the tracks around the disk into pie like slices called sectors which make 

it possible for your computer to save and retrieve information. The density of the bits on the track and 

number of tracks on a disk determine the number of characters that can be stored.  

Floppy disks are identified as being double density or high density. Most machines purchased after 1993 

will use a high-density disk. A machine that has a double density drive can't process a high-density disk. 

Note the chart below for disk information.  

Floppy Disk Capacity  

Description  Bytes  

5  inch disk    

Double-sided, double-density  360 KB  

Double-sided, high-density  1.2MB  

3  inch disk    

Double-sided, double-density  720 KB  

Double-sided, high-density  1.4 MB  

1.4 MB is equal to 500 pages of text.   

Floppy disks must be handled with care to preserve data. Follow the suggestions to protect your floppy 

disk.  

1. Store in box or disk storage container.  

2. Protect disk from dust.  

3. Keep disk out of sunlight and away from extremes of hot or cold.  

4. Don't press hard when writing on labels. Use a felt tip pen.  

5. Insert metal side into drive first with the hub of the disk down.  

6. Don't store disk near magnetic sources.  

Hard Drive - Much like a floppy, the hard disk located inside the computer case is made of a stack of 

rotating disks, called platters. Data is recorded on a series of tracks that have been divided into sectors.  

Most computers have one hard drive, located inside the computer case. If a computer has one hard drive, 

it is called drive C. If a computer has additional hard drives, they are called drives D, E, and so on. A 

hard drive stores your programs. When you buy a new program, you must install the program files to 
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your hard drive before you can use the program. A hard drive stores your data files such as documents 

spreadsheets, and graphics.  

CD-ROM Storage - Since each CD-ROM can store 600 million bytes of data or 300,000 pages of text, 

they are today's answer to make you computer feel like a machine twice its size. Because of its external 

storage, you can use your machine to access an encyclopedia, games, graphics, and a variety of sources 

that use large amounts of memory.  

  

Evolution of Computers:  

Sand Table  Ancient 

Times   

  

Pebbles were used in place of fingers. It consisted of 

3 grooves with 10 Pebbles in each groove.  

ABACUS  5000 yrs.  

Ago  

  

Abundant Beads Addition and Calculation Utility 

Systems. Developed in Asia Minor.  

Napier Bones  1614  

 

John Napier(Scottish). A small instrument made of 

10 rods on which multiplication table was engraved.  

Slide Rule  1620  

 

Edmund Gunter & William Oughtred Multiplication  
and division by the method of Addition and 

subtraction can be done.  

Calculating Clock  

    

1623    William Schickard  Yhis machine helped in the 

evolution of Pascaline.  

Pascaline  1642  

 

Blaise Pascal  1st Functional Automatic 

Calculator  

Stepped Reckoner  1694  

 

Gottfried Wilhelm Von Leibriz (German)  
Multiplication, Division and Square root was done.  

Punched Card Machine  1801  

 

Joseph Marie Jacquard (French Textile Weaver)  
It was a power loom with an automatic Card Reader  

Difference Engine  1822    Charles Babbage (English) Father of Computers 

It was used to generate Mathematical Tables  

Analytical Engine  1836    Lady Lovelace Ada Augusta (1st Programmer)  

It was 1st General purpose programmable computer. 

It was used to test the sign of a computed number, 

negative or positive.  

Hollerinth Tabulator  1894  

 

In 1896,Herman Hollerinth founded Tabulating  
Machine Company which was later named IBM  
(International Business Machines)  

1st Thermionic valve 

(Vacuum Tube)- Diode  
1904    Sir John Ambrose Fleming  

Cornerstone of 1st Generation computers  
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Digital computing  1906    Lee De Forest (American)  
Introduced a third electrode into diode  

Differential Analyzer  1931    Vannevar Bush to solve 

Differential Equations.  

Digital computer   1938     Claude Shanon, an MIT student using 

electronic circuits and Boolean algebra.  

  

  

  

Mark I  1937-44  Howard Aiken  

  

Mechanical components were replaced by        

Electromagnetic components  

ABC  1939  John Vincent Attansof  

& Clifford Berry  

Attanasoff - Berry Computer used Binary arithmetic 

logic circuits using Boolean Algebra  

Colossus  1944  Alan Mathison  

  

One of the world’s working Programmable Electronic 

Digital  

ENIAC  1946  John Eckert &  

 John Mauchly  

  

Electronic Numerical Integrator and Calculator  

18000 Vacuum Tubes and 300 Crystal Diodes, speed 

1000 times  

EDVAC  1949  John Presper &   

John W. Mauchly  

  

Electronic Discrete Variable Automatic Computer  

Based on John Von Neumann’s concept,  

1st Electronic Computer using Stored Program  

Concept used 4000 Vacuum Tubes and 10000 Crystal  

EDSAC  1949    Electronic Delay Storage Automatic Calculator. Also 

based on John Von Neumann’s concept   

3000 Vacuum Tubes on 12 racks.  

UNIVAC I  1951  Eckert-Mauchly  

Corporation  

  

Universal Automatic Computer  

5000 Vacuum Tubes, 18000 Crystal Diodes and 300  

Relays were used. It was the 1st General purpose 

Computer. Designed to handle both numeric and 

textual information.  

  

COMPUTER GENERATIONS  

  

Generations  Technology Used  Period  Characteristics  Specific Examples  

First  Vacuum Tubes  1942-55  Huge and expensive, limited speed 

and versatility, difficult to program 

as each computer had its own 

binary-coded machine-language 

program, used magnetic-drums for 

data storage.  

Mark-I ENIAC,  

EDVAC, UNIVAC  

Second  Transistors  1955-64  Relatively smaller, cheaper, faster, 

more reliable and energy efficient 

to simplify programming high-level 

languages such as Algol, COBOI 

and Fortran were introduced.  

IBM 1401, ATLAS 

B-5000, MINSK-2, 

ICL 1901.  
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Third  Integral Circuits 

(SSI and MSI)  

1964-75  Mass production of small-sized 

low-cost computers, used technique 

of multi-programming, introduced 

operation systems to handle users 

and programs concurrently Concept 

of time-sharing and easy to learn 

language, basic was introduced.  

IBM 360, UNIVAC  

1108, HP 2100   

Fourth  Very Large Scale  

Integration (VSLI) 

Ultra-Large Scale  

Integration (ULSI)  

1975- on 

ward  

More powerful, smaller, cheaper 

for general purpose development of 

micro-processor, micro-computers 

and PCs take place, introduces wide 

variety of application softwares, 

User’s friendly interfaced operating 

systems (i.e., Windows) introduced.  

ICL 2900, HP 9845 A 

VAX 11/780  

Fifth  Artificial 

Intelligence  

Yet to come  May be able to accept human 

instructions in voice and work 

logically at its own.  

Under process.  

  

    

 

  

  Basic organization of a computer system  

Computer system performs following main basic operations:  

1. Inputting: It is the process of entering data and instructions into the computer .  

2. Storage: The data and instructions are saved in the computer for further application. we can recall these 

information for further use.  

3. Processing: It performs arithmetical and logical operation to convert them into meaningful results.  

4. Outputting: It is the process getting final results. It may be obtained in the form of printed handout or in 

monitor.  

5. Controlling: It directs the sequence for executing as to control the fashion in which computer system may 

be allowed to work.  

Input Output device  

  

Input device  Output device  Storage device  

Keyboard  Monitor  Floppy Disk  

Mouse  Printers (all types)  Diskette  

Pen Input  Audio Card  Hard Disk  

    PROGRAM    

       & DATA   

  

  

  

  

  

  

  

  

  

  

CENTRAL   
PROCESSING   

UNIT   

INPUT     
UNIT   
  

STORAGE   
UNIT   

OUTPUT     
UNIT   
  

CONTROL   
UNIT   

ARITHMETIC   
LOGIC   
UNIT   

R ESULTS   
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Touch Screen  Plotters  Disk Cartridge  

Light Pen  LCD Projection Panels  CD-ROM  

Scanner  Computer Output Microfilm (COM)  Optical Disk  

Microphone  Facsimile (FAX)  Magnetic Tape  

Electronic Whiteboard  Speaker(s)  Cartridge Tape  

  

Units of Memory - Storage device  

Basic Unit of storage is Byte  

8 bits = 1 byte 1024 

Bytes = 1 K.B.  

1024 K.B. = 1 M.B.  

1024 M.B. = 1 G.B.  

 

Memory Unit  

  

Data or information are stored into this device temporarily or permanently. Initially, the data is entered into the 

computer system, it goes into a memory called Primary Memory and for permanently storing the data, the device 

used is called Secondary Memory.  

RAM (Random Access Memory)  

  

It is a primary memory, because when the data are entered through keyboard into computer system, they firstly go 

to RAM.  

It is volatile in nature, because it is made up of semi-conductor substance (silicon). Volatile means that the data 

will be lost from primary memory RAM in case of power failure, if it is not transferred into secondary storage 

device. RAM is a Read & Write memory both, because both the operations can be done to it. RAM is a place in a 

computer where the operating system, application programs and data in current usage is kept, so that they can be 

accessed by the processor.  

ROM (Read Only Memory)  

CPU can only read from any location in the ROM, but cannot write. It is non-volatile. The instructions in ROM 

are built into the electronic circuits of the chip. The instructions are called Firmware. A regular ROM is constructed 

from hard-wired logic encoded in the silicon. It is designed to perform a specific function and cannot be changed.  

PROM (Programmable ROM)  

It is a type of ROM that can be programmed using special equipment, which can be written once only. Programming 

a PROM is also called ‘Burning’, just as burning a CD-R  

EPROM (Erasable Programmable ROM)  

                                                                 G.B. =  1024    T.B. 1   

                             Sto rage device   

  

  

  Primary Memory            Secondary Memory   

  

  

  

  RAM   ROM   Magnetic Tape         Magnetic Disk     Optical Disk     

                                 ) SASD)                 (DASD (   

  

  CD                DVD   

       DRAM       SRAM    PR OM   EPROM   EEPROM   

                       Hard Disk       Floppy Disk   
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An EPROM is a ROM which can be erased and reprogrammed. It can be erased by using an ultraviolet light of a 

specific frequency for a specified period of time. EPROM is much more useful than a regular PROM. This 

technology is analogous to a reusable CD-RW.  

EEPROM  

This is commonly used for holding BIOS programs. An EEPROM can be erased under software 

control. Erasing is done electrically without removing ROM or PROM from the socket. BIOS contain 

all the programs needed for all basic low level operation and control of the hardware.  

WINDOWS  

Salient features of Windows Operating System:  

1. It converts the plain character based user interface provided by DOS into a Graphical User  

Interface(GUI) such as pictures, symbols and words on wer screen that can be controlled by the        

mouse.  

2. It provides a multitasking capabilities to the PC.  

3. It supports long file name rather than the limited 8 characters with extension of three letter file name 

(8:3) as used by DOS. In Windows file name can have name up to 255 characters long.  

4. Windows owes its name to the fact that it runs each program or document or application in its own 

separate window.  

5. Windows have the facility of accessories such as Word pad, Note pad, Calculator and Paint.  

6. User can paste portion of one document into another by utilizing more advanced document linking      

features called Dynamic Data Exchange (DDE), Object Linking and Embedding (OLE).  

7. It provides a big facility of plug and play standard. It allows user to simply plug a new board such as 

a  video, audio or network card into the computer without having a set of switches or making other    

settings.  

8. If a program crashes, then it will display fault error message about its crash and we can eliminate     

the crashed program from the task list without affecting other running applications.  

   

Parts of a window screen:  

Desktop: The desktop is the on-screen work area on which Windows, Icons, menus & dialog boxes 

appear. The Desktop can have several components. Parts of the desktop include Icons & the taskbar.  

  

Components of the Desktop:  

• Icons  

• Taskbar  

Icons: Icon is a small image that represents a file, folder or program.  

They are:  

• My Computer  My documents  Internet Explorer  Recycle bin  Network Neighborhood  

My Computer: This is the icon which represents all the files & folders which can be used in the ystem. 

It is used to access the drives, folders & files on the computer. i.e Floppy drive (A), Local C, D, E, 

Printer, Control Panel etc.  

My Documents: This is the default storage location for the files created in the windows.  

Internet Explorer: This is an application used to browse the internet.  

Recycle bin: This is a folder that stores all the files & folders deleted from windows temporarily, which 

can be restored again if needed.  

Network Neighborhood: This is an application which display all the computers connected in network 

with our computer.  
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Taskbar: The rectangular bar that runs horizontally across the bottom of the screen is called Taskbar. 

The Taskbar has the START menu on the left & the Notification area on the right. We can start an 

application using the start menu.  

Notification area holds system icons that allow for functions such as changing the time & Volume  

of the Computer. All the open applications are available on the Taskbar.  

  

Title bar – This is the title of the window, like wer name at the top of a piece of paper. The Title 

bar is also the handle for the window. If we click and hold the mouse button down on the title bar, 

we can move it around the screen.  

 Minimize – To have a window take the minimum amount of desktop space possible, click 

the                   minimize button. This drops the window into the Task bar like a piece of paper going 

into a                   drawer. The Task bar will show the task whether or not the window is minimized.  

 Maximize – To have a window take the maximum desktop space, click the maximize button.  

                  This stretches the window out like an architect‘s floor plan being rolled out over the desk.  

 Restore – A maximized window will cover over all the other windows and icons on the  

desktop. The Restore button places the window back so that more than one window can 

display at a time.  

 Close (X) – When done with a window, we can have it taken completely off the desktop by  

                   closing it. Use the X button to do this.  

Menu bar: The Menu bar displays a list of commands that can be used to perform various tasks. ( this                     

will be below the Title bar). Menu items are commands within the menu bar that allow         choosing of 

functions & tasks.  

Tool bar:   Contains a set of buttons for frequently used commands.  

Scroll Bars: On the bottom and right edges of a window we find scroll bars. They are used to pan                        

across the information in the window, when we have information which won‘t fit into the   window. The  

Status Bar: The Status bar appears at the very bottom of the window and provides such information as                        

the cursor position, current page number, the number of words in the document etc.  

  

WINDOWS EXPLORER  

  

     Windows Explorer is an application that provides detailed information about wer files, folders, and 

drives. We can use it to see how wer files are organized and to copy, move, and rename files, as well as 

perform other tasks pertaining to files, folders, and drives.  

Explorer uses the directory windows to graphically display the directory structure of wer disk and  

files. Windows Explorer displays the contents of the entire system in a hierarchical manner.  

  

To open Windows Explorer, click Start → All programs → Accessories → Windows Explorer  

  

        Windows Explorer is divided into 2 panes. The left pane displays the list of drives & folders on the 

computer. The right pane displays the contents of the selected drive or folder. By using these two panes, 

we can browse through the contents of wer computer in a single window. Folder is a list of files (similar 

to Directory in MS-DOS)  

Working with Folders:  

Creating a Folder:  
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1. From the tree pane : select the directory under which we want to create a sub directory.  

2. Choose File→New→Folder. On the right pane of the screen, a new folder is created.  

3. Type in the name of the directory and press ENTER. We can notice the change in the tree     structure 

immediately.  

Creating files:  

After creating a folder, we can move files into it or create new files within the folder.  

Selecting files & folders:  

i) To select all the files in a folder:  

Click the folder in the left pane → All the files will be displayed in the right pane.  

To select all --→CTRL + A ii) 

To select consecutive files:  

Use shift key + arrow keys iii) 

To select non-consecutive files:  

• In the right pane of Windows Explorer, click the first item to be selected.  

• Hold down CTRL  

• Click all other items that need to be selected.  

Copying Files & Folders:  

Once we select the files to be copied, the next step is to copy the files.  

To copy the files & folders:  

ii) In Windows Explorer, select the file or folder to be copied.  

iii) On the edit menu click copy  

             ( the files are copied to the clip board. The clip board is a location where the information we 

copy or cut is temporarily stored) iii) Click the destination folder in the left pane.  

iv) In W.Exp, click paste in the Edit menu.  

      Alternatively, to copy a file or folder, select it and then press ctrl +C.To paste, press ctrl+ V  

  

  

To move the files or folders:  

i) select the folder to be moved. ii) On the 

edit menu, click cut iii) Click the destination 

folder in the left pane iv) On the edit menu, 

click paste.  

Alternatively, to cut a file or folder, select and press ctrl +X & then to paste, press ctrl +V.  

Renaming files or folders:  

i) Select the item to be renamed ii) 

Choose File → Rename  

iv) Current name gets selected, Type in the new name iv) Press Enter.  

Deleting files or folders:  

If we do not want certain files or folders, we can delete them. All the files & folders which 

are deleted are moved to the recycle bin. To delete: i) Select ii) On the file menu, click 

delete or press delete.  

A warning appears prompting we to confirm the file deletion. 

iii) If we want to delete, click yes otherwise No.  

Note: To delete a file permanently without moving it to the Recycle bin, select the file & then press 

Shift+ Del.  
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MS-WORD  

  

MS- Word I  

It is a word processor. The extension name of MS- word is .doc. It is an application used to create, 

edit, print and save a document. It allows the user to insert pictures, tables, charts, drawings & features 

that will make the text richer & more interactive.  

( The term document refers to a file created using word processor) Starting 

MS-Word:  

Start → All Programs → MS-office→ MS-word MS-

word icon is w.  

The default Word document includes the following lawet tools:  

• Title bar: displays the document name and the application.  

• Menu bar: Contains the list of menus available inside word, each menu contains a specific set                        

of commands.  

• Standard toolbar: provides shortcuts in the form of buttons for frequently performed tasks.  

• Formatting toolbar: Contains a list of formatting options available inside the format menu.  

• Horizontal & Vertical rulers: used for measurement purposes like any normal ruler; the                                     

default unit of measure is in inches.  

• White page area: is the space area where we type, edit and format wer document.  

• Insertion point : is the blinking vertical line that indicates the position on the screen where text                                   

or graphics will be placed.  

  

• Task pane : is a small window within the word window that provides shortcuts to commonly                           

used tasks.  

• Scroll bars : are used to move up and down or left and right in a document.  

• Status bar: displays the details such as the page number the user is working on, section no.,                          

page no. out of the total pages found in the document, line number, column number etc.  

Standard Toolbar:  
This toolbar contains buttons to allow we to perform the basic operations such as opening and 

closing a document, moving and printing data.  

 
  

Function of commonly used buttons  

• New: Creates a new blank document based on the default template  

• Open: Opens or finds an existing file  

• Save: Saves the active file with its current file name, location and file format  

• Print: Prints the active file - for more print options go to the File menu and select Print Print 

preview : Shows how the document will look when we print it.  

• Spelling & Grammer: Spelling, grammar and writing style checker  

• Cut : Removes the selection from the document and places it on the clipboard  

• Copy : Copies the selected item(s) to the clipboard  

• Paste : Places the content of the clipboard at the insertion point  

• Format painter : Copies the format from a selected object or text and applies to other objects  
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• Undo : Reverses the last command, use pull-down menu to undo several steps  

• Redo : Reverses the action of the Undo button, use the pull-down menu to redo several steps  

• Insert table: Insert a table into the document, or make a table of selected text  

• Insert Excel worksheet: Inserts an Excel spreadsheet into the Word document  

• Columns : Changes the number of columns in a document  

• Drawing: Displays or hides the Drawing toolbar  

• Zoom (100%): Enlarge or reduce the display of the active document.  

Formatting Toolbar:  

The formatting Tool bar is the easiest way to change many attributes of a text.  

 
 

  

Style menu: Allows we to make wer text Bold, Italic, underlined… depending on the style we choose.  

• Font: Allows we to change the font by clicking on the drop-down arrow on the right of the                

font name box. We can view a list of fonts available, we can scroll down to view more fonts                

and select the font name we wish to use by clicking on its name.  

• Font size: Allows we to change the font size by clicking inside the Font size box and entering 

a                        value or by clicking on the drop-down arrow on the right of the box to view a 

list of sizes                        available. Select then a size by clicking on it.  

Note: A Font size of 11 or 12 is best for paragraphs of text.  

• Bold, Italic, Underline: Each button respectively allows we to make wer text appear as bold,                                                

italic or underlined.  

• Alignment: Each button respectively allows we to make wer text aligned to the left, center or                          

right side of the page. We can also justify the text across the page using the justify button. 

Line spacing: Allows we to set the amount of space that word puts when go to a new line. 

Text orientation: Allows we to change the typing direction of wer text, from left to right or                                     

right to left manner.  

• Numbering, Bullets : Allows we to make wer text appear as a bullets list or as a numbering   

list.  

• Increase / Decrease indent : Allows we to increase or decrease the indentation of wer                                                          

paragraph in relation to the side of the page.  

• Outside Border : Allows we to add a border around a text selection.  

• Highlight color : Allows we to change the color behind a text selection.  

• Font colour : Allows we to change the colour of the text.  

Features of FILE MENU ( ALT F):  

1. New - Opens new Word file (Blank Document file)  

2. Open - Opens the existing files  

3. Save - Saves the file with one name  

4. Save as -Saves the file with more than one name( with different formats)  

5. Save as Web page – This is used to save a document in a Web style. (with HTML extension) 6. 

Versions - This is used to do the parts of work in small parts. i.e a bulk ( big/ more) work can be                          

done in small parts.  

7. Web Page Preview – This shows the web page in printable form.  
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8. Page set up - To set the margin, paper size, Orientation 9. Print - To get the 

printout.( Specified pages and no. of copies).  

10. Properties - This gives the details about the document ( the type of file, the size of file, the date of 

creation, date of modification and file location)  

11. Send - This is used to send the file document to internet mail to some other person.  

12. Exit - To close the Ms-word.  

To insert a new page, press Ctrl + Enter  

Features of FORMAT MENU ( ALT + O)  

1. Font - used to change the font face, style, size etc.  

2. Paragraph - Used to set the space between paragraphs and also between the lines  

3. Bullets - Used to highlight points in number wise / bullet wise.  

4. Borders & Shades - Used to apply different borders to the table / to the page.  

5. Columns – Used to write the text in column wise.  

           To have a break in columns, a column break is used ( insert menu → break → Columns)  

           Ctrl + Shift + Enter  

6. Drop Cap - Used to drop the letter to different lines.  

  

7. Text direction - Used to change the direction of drop cap (Note : To use text direction, drop                                  

cap must be used first)  

8. Change case - Used to change the case of the text.  

9. Toggle – This converts lower case letters to upper case & vice –versa in a word.  

10. Back Ground - This is used to change the back ground color of the document but the color                                    

can be seen only in the web lawet.  

11. Theme - This is used to change the document, backgrounds with some existing design                        

background. This shows the background only in the web lawet.  

12. Style - This is used to change the writing fashion of the document which are already existing. 13. 

Frames - Frames are used to write different documents in one single document Some important 

features of Tools menu:  

Spelling &Grammar : Used to check the spelling and correct the words with related word. ( 

F7) Thesaurus : Used to know the synonym (meaning) of the word. (Shift +F7) Mail merge 

: used to type the letters with the same matter but different addresses.  

Working with files  

Creating a New document:  

• Click the New Blank document button on the standard tool bar. (or)  

• From the Menu bar, choose File → New, the New document task pane will open, and select     Blank 

document.  

Opening Existing documents:  

• Click the open button found on the Standard tool bar. (or)  

• From the task pane, select getting started and the select more (or)  

• From the Menu bar, select File → Open Saving a document:  

• Click the Save button on the Tool bar. (or)  

• From the Menu bar, select File → Save (or)  

• Follow the key sequence Ctrl + S  

Save dialog box appears. Type the name and click Save. Printing 

a document :  
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• Select File → Print (or)  

• Click on the Print button on the Standard Tool bar (or)  

• Click Ctrl + P  

Print dialog box appears. Select All pages (or) Current page (or) type the page numbers and 

also select number of copies according to the requirement and click O.K Closing a document:  

• Select File → close  

• Click on the small X found on the right top next to the Menu bar and the Title bar. Editing Text :  

Typing and Inserting Text:  

To enter text in war document, position the insertion point i.e. a vertical blinking line, where we 

want the text to appear and type it in.  

Word will automatically wrap text as it reaches the end of a line. Press enter to start a new paragraph. 

When we reach the end of a page, word will automatically break text onto the next page. If we want, we 

can start a new page at any point by inserting a page break. To do so, press ctrl +Enter.  

Word offers two modes for adding text to war documents: Insert mode and overwrite mode. In 

Insert mode, characters typed are inserted into the text to the left of the insertion point, pushing any 

characters to the right of the insertion point further to the right. In overtype mode, the text we type will 

replace the existing text.  

Note: The Insert key is a toggle key. This means that the same key can be used to switch back and forth            

between two different modes.  

Selecting Text:  

In order to change the format of the text we just typed, it must be first highlighted, i.e selected 

with the mouse cursor.  

To highlight the whole text or part of it, locate the mouse at the start of the text we wish to highlight 

and click the left button, then drag the mouse over the desired text while keeping the left mouse button 

pressed.  

Shortcuts used for selecting a portion of the text:  

• Whole word : Double click within the word.  

• Whole paragraph: Triple click within the paragraph.  

• Sentence : ctrl + click in a sentence  

• Entire document : Edit → select all ( ctrl + A) Deleting text:  

• Use the BACKSPACE or the DELETE key to delete text.  

• BACKSPACE key will delete text to the left of the cursor and DELETE key will erase text to 

the          right.  

• To delete a large section of text, highlight the text using any of the methods outlined above and    

press the DELETE key.  

Moving, copying and pasting text:  

Cut text:  

Highlight the text we need to move and follow one of the methods listed below:  

• From the Menu bar, select Edit → cut (or)  

• From the standard tool bar, click on the cut button. (or)  

• Follow the key sequence Ctrl + X Copy text:  

• From the Menu bar, select Edit → copy (or)  

• From the standard toolbar, click the Copy button (or)  

• Follow the key sequence Ctrl + C  
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Paste Text:  

To paste previously cut or copied text, move the cursor to the location we want to move the text 

to and follow one of the methods listed below:  

• From the menu bar, select Edit → Paste (or)  

• From the standard Tool bar, click the Paste button (or)  

• Follow the key sequence Ctrl + V  

MS -EXCEL  

Spreadsheet is software that helps to substitute the paper worksheets in the offices. Spreadsheet displays 

data in the form of rows and columns. An intersection of row and column is known as a cell.  

MS-Excel is a window based spreadsheet developed by Microsoft Corporation. It includes all 

features of a spreadsheet package like recalculation, graphs & functions. It also provides many 

Mathematical, Financial & Statistical functions. Thus it is used in many scientific and engineering 

environments for analyzing data. Excel can even hold graphic objects like pictures & images.  

  

Some important features of MS-Excel:  

1. Window based application: Excel like all other applications has Toolbars, Shortcut Menus,      

Auto correct, Online help and Wizards.  

2. Workbooks: Workbooks are the files in which worksheets related to a project are held.  

3. OLE support: Object linking and Embedding is a feature through which Excel can contain any 

object like a document, a picture etc.  

4. Maintaining high volume of data: Excel can contain large volume of data. A worksheet can 

contain 65536 rows and 256 columns. A single cell can contain a maximum of 255 characters.  

One workbook can contain a maximum of 256 worksheets.  

5. Availability of functions: Several Mathematical, financial & statistical functions are available in 

an Excel package.  

6. Availability of Charts & Graphs: MS-Excel allows users to view data entered as tables in a 

graphical form as charts, which helps the user to easily understand, analyze data & compare data.  

7. Data Analysis Tools: MS-Excel provides a set of data analysis tools called Analysis Tool pack.  

8. Sorting capability: Excel has the capability of sorting any data in Ascending or Descending 

order.  

9. Auto fill feature: Excel has the feature which allows to fill cells with repetitive data such as 

chronological dates or numbers and repeated text.  

Getting started with Excel:  
An Excel document is called a workbook. By default, Excel workbook contains 3 worksheets 

designated as sheet 1, sheet 2, sheet 3.  

The extension name of excel workbook is .xls We 

can start excel in many ways:  

1. Start → Programs → Microsoft office → Microsoft Excel → hit enter.  

2. Start → Run → Type Excel → hit enter  

3. Double click on the Microsoft application Icon.  

• Rows, columns & cell: In a worksheet rows are numbered from top to bottom. The columns are labeled 

with letters from left to right. Rows are numbered from 1 to 65,536 and columns labeled from A to IV 

(256 columns).  

• Title bar: The title bar contains the name of the program Microsoft Excel and the default name of the 

workbook Book1 that would change as soon as we save wer file and give another name.  
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• Menu bar : The Menu bar contains menus that include all the commands we need to use to work our 

way through Excel such as File, Edit, View, Insert, Format, Tools, Data, Window and Help.  

• Tool Bar: Tool Bars are usually shortcuts for menu items. Standard and formatting toolbars are 

displayed by default.  

• Active cell: The cell in which we are currently working.  

• Formula bar: displays the contents of the active cell.  

• Name box: displays the cell address of the active cell. Column letter followed by the row number.   

      Ex: B6  

• Worksheet area:   

The middle portion of screen which occupies a major area is called worksheet area. In this area, 

information or data (i.e.) either textual or numerical can be entered and the results can be displayed. A 

worksheet is a large work area of 65,536 rows and 256 columns.  

• Status bar: located at the very bottom of the screen displays brief information about activating features 

within the worksheet area.  

• Sheet tabs: appear above the status bar displaying the names of the worksheets.  

Standard Toolbar  

`The Standard toolbar, located beneath the menu bar, has buttons for commonly performed tasks 

like adding a column of numbers, printing, sorting, and other operations. Excel let's we customize the 

toolbar or even display multiple toolbars at the same time. The Standard Excel XP toolbar appears in the 

figure below  

   
Formatting toolbar  

The Formatting toolbar, located beneath the Standard toolbar bar, has buttons for various 

formatting operations like changing text size or style, formatting numbers and placing borders around 

cells.  

  

 
  

Formula bar & Name box  

The formula bar is located beneath the toolbar at the top of the Excel worksheet. Use the formula 

bar to enter and edit worksheet data. The contents of the active cell always appear in the formula bar. 

When we click the mouse in the formula bar, an X and a check mark appear. We can click the check icon 

to confirm and completes editing, or the X to abandon editing.  
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Name box  

The Name box displays the reference of the selected cells in the form of column label followed 

by row number.  

Creating a New Workbook:  

The steps to create a new workbook are,  

1. On the File menu, click New.  

The new workbook task pane appears at the right side of the screen. Click blank workbook. A new 

workbook with 3 worksheets appears. By default, the workbook is named as Book 1, and sheet 1 is the 

active worksheet & A1 is the active cell.  

Entering data:  

We can enter text, numbers and dates in an Excel worksheet.  

To enter data of any type,  

1. Select the cell by clicking on it.  

2. Type in the information.  

3. Press the Enter key.  

When we begin typing, the data also appears in the formula bar.  

Editing text:  

The easiest way to edit the contents of a cell is to select the cell and then retype the entry. The new 

entry replaces the old contents.  

Alternatively, to edit the data in a cell, press F2.  

Ex: Suppose we find that in the cell A6, we have entered the marks as 78 instead of 87, then click 

on A6 and type 87 →enter  

We can also edit part of the data in a cell:  

1. Double click the cell we want to edit. The insertion point appears within the cell.  

2. Delete the part of the data that we do not wish to keep.  

3. Retype the data & press enter.  

Formatting a worksheet:  

Changing the style or appearance of data in a worksheet is called formatting. We can format the 

data in a worksheet by:  

• Changing the position of data in a cell  

• Changing the font, size, style & colour.  

Aligning data:  

By default, any text we enter in Excel is aligned to the left and any value or number is aligned to 

the Right. To change the default alignment, we can use the alignment buttons on the formatting tool bar.  

  

  

Formatting Numbers:  
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Formatting data in a worksheet includes 

changing the number of decimal places, displaying 

dates, times & fractions and adding currency symbols.  

To format the number in a cell, the steps are:  

Format/Cell/N/umber/Decimal places/2  

Formatting Text: Text can be formatted using the 

buttons on the formatting toolbar. Font of a cell, font size can be changed. The font style can also be 

changed to bold, Italic etc.  

Inserting Rows & Columns:  

In Excel, rows & columns can be inserted or deleted without affecting the surrounding rows, 

columns & cells.  

To insert a row,  

1. Rest the mouse pointer over the row above which we want to insert the new row.  

2. On the Insert menu, click rows.  

A row is inserted and the existing row moves down after the new row.  

Similarly, to insert a column,  

1. Rest the mouse pointer over the column before which we want to insert the new Column.  

2. On the Insert menu, click columns.  

Changing Row height & Column width:  

By default, every row is 12.75 points high and every column is 8.43 characters wide. As we fill it 

with data, however we have to change the size of rows & columns so that it is fitted to the length of the 

data.  

To resize a column:  

1. Rest the mouse pointer on the column boundary on the right side.  

2. The shape of the mouse pointer changes to  

3. Drag the boundary until the required width is obtained. (OR)  

1. The column which is to be adjusted is made active by clicking on column letter.  

2. The column option is selected from the Format menu.  

3. Click on the width option. A dialogue box is displayed.  

4. Type in the required size of the column in the text box column width.  

Similarly, Row height can also be adjusted by selecting the rows.  

Sorting: Highlight the cells that should be sorted and click the sort Ascending (A-Z) button or Sort 

Descending (Z-A) button found on the Standard toolbar.  

Printing: To print the worksheet, select File →Print from the Menu bar (or) click on the Print button 

from the Standard Toolbar (or) follow the key sequence Ctrl + p  

Inserting Page breaks: To set the page breaks within the worksheet, select the row we want to appear 

just below the page break by clicking the row‘s label. Then choose Insert → page break from the 

Menu bar.  

When we attempt to print a worksheet Excel automatically inserts page breaks view.  

File menu → page break preview  

The page breaks are shown in dasher lines. If the automatic allocation of page breaks does not satisfy 

with wer requirements, we can add the page breaks in the required space.  

Step 1: select a cell above which the page break is needed. After that, select the full row until the data in 

the sheet exists.  
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Step 2: select insert →page break Saving 

a workbook:  

To save a workbook,  

• File → Save (or)  

• Ctrl +S (or)  

• click on the save button on the Tool bar.  

Save dialogue box appears. Type the name and click Save.  

Formulas:  

In Excel. One of the powerful features is formulas. A formula is an equation that is used to perform 

calculations on data in a worksheet. We can use formula to perform Mathematical, Statistical & date/time 

operations on a single value or a set of values by using operators.  

The cells in which formulas are stored, display the result of the calculation and not the formula. 

In Excel, a formula must start with an equal (=) sign. We can use any number of operators in a single 

formula. MS- Excel evaluates the formula according to the order of precedence of the operators.  

  

Operator  Operation Order of  precedence  

(  )  Bracket  1  

^  Exponentiation  2  

* , /  Multiplication , Division  3  

+ / -  Addition, Subtraction  4  

&  Concatenation  5  

= / > /<  Comparisons  6  

  

Four functions can be performed in MS Excel  

1. Text function  

2. Mathematical function  

3. Logical function  

4. Statistical function    

MS- Power Point  
PowerPoint is a tool you can use to communicate your ideas effectively through visual aids that 

look professionally designed yet are easy to make. With PowerPoint, you can create slides for your 

presentation in the output you require: blank and white overheads, color overheads, 35mm slides or 

onscreen electronic slide shows. In addition, you can prepare speaker’s notes, print an outline and print 

audience handouts. All these components in one file make up a PowerPoint Presentation.  

To launch PowerPoint, Click the Start Button on the Windows Taskbar, select Programs and then 

click on Microsoft PowerPoint. You might also find the Power Point icon on your MS Office Toolbar. 

The Power Point startup as shown below. To begin working with PowerPoint, you will need either to 

open an existing presentation or create a new presentation using one of available options. They are  

➢ Blank Presentation  

➢ From Design template  

➢ From Auto Content Wizard  

➢ From Existing Presentation Photo album.  

Creating a New presentation  
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Whether your presentation will be in the form of an electronic slide show, 35mm slides, 

overhead or just paper print-outs, the process of creating a PowerPoint Presentation is basically the 

same. You can start with a template, a design template or a blank presentation. To get to these three 

basics form, there are three options.  

Blank Presentation  

The blank Presentation template is a design template that uses the default formatting and design. 

It is useful if you want to decide on another design template after working on the presentation content or 

if you want to create your own custom formatting and design form scratch.  

Design Template  

After a few presentations on your own, you more than likely will always choose this option so as 

to have complete control over your presentation. A design template is a presentation that does not contain 

any slides but includes formatting and design. It is useful for giving your presentations a professional and 

consistent appearance. You can start to make a presentation by selecting a design template or you can 

apply a design template to an existing presentation without changing its contents.  

Creating Slides  

When you create a new presentation using a template (including the Blank Presentation template), 

you start with first and then continue to build the presentation by inserting new slides.  

Inserting New Slides  

To add a new slide after the current slide in Slide View:  

➢ Choose New Slide From the Insert menu, or  

➢ Click the Insert New Slide button on the Standard toolbar  

This bring up the New Slide dialog box. On the New Slide dialog box PowerPoint gives you a set 

of available slide layouts, called Auto layouts, to choose from. An Auto Layout contains placeholders for 

titles, Text and objects such as clip art, graphs or tables that you may want to put on a slide. You are not 

limited only by this option. As you will see later in the handout, anything can be added to any slide. To 

create slide, click an Auto layout icon that matches the layout of the slide you want to make; the name of 

the selected Auto layout appears in the lower right side on the dialog box. Then click OK and the new 

slide appears on the screen. Adding Text to Slides  

You can insert text on slides by selecting an Auto Layout with text placeholders. Text placeholders 

are formatted for titles and bulleted lists. The text formatting, which includes the font, alignment and 

bullets, depends on the design template you selected.   

Tables  

To inset a Microsoft Word table on a slide:  

➢ Double-click on a Table Placeholder,  

➢ Click on the Word Table Button shown here, or  

➢ Under the Insert menu, choose Picture, then Word table  

And specify the number of rows and columns you want. If you click on the Insert Microsoft word 

Table button on the standard toolbar, drag on the cells to select the number of rows and columns. The 

table appears along with Word’s application menu and toolbars. Type the table contents and, when you’re 

finished, click anywhere else on the slide. To edit the table, double-click on it and edit the table using 

Word tools and menus.  

Clip Art:   

You can put graphic images from Microsoft ClipArt Gallery on your slides. To add Clip Art to a 

slide:  

➢ Double-click on Clip Art placeholder.  
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➢ Under the Insert menu, choose Picture, then clip art.  

Click the Insert Clip Art button on the Standard toolbar  

  

  

Deleting a Slide  

To delete a slide in Slide View, select Delete Slide from the Edit menu. In Slider Sorter View, Select a 

slide and hit the delete key from your keyboard  

  

  

MS ACCESS  
Introduction  

A database is a computer program for storing information in an easily retrievable form. It is used 

mainly to store text and numbers (for example, the Library catalogue, which includes the author, title, 

class number and accession number for each book). Most modern databases also allow the storage of 

other types of information such as dates, hyperlinks, pictures and sounds. As well as being able to store 

data, a database allows us to select information quickly and easily (for example, a list of the books written 

by a particular author or those on a certain subject).   

DBMS (Database Management System) is an application that enables to maintain data in a database. 

Maintaining data involves storing, organizing and retrieving data.   

Microsoft Access is a relational database management system (which allows us to link together data 

stored in more than one table). The extension name of Ms-Access file is .mdb.  

  

To start MS-Access:  

1. Start→ Programs →MS office → Ms-Access → Enter  

2. Start → Run →Ms-Access →Enter  

  

An Access Database consists of 7 different Database objects.  

1. Tables : Store database data in Rows (records) and columns (fields). Every row represents a 

Record. Each piece of information in a record is called a Field.  

Ex: A table can contain personal information about all the students in a college.  

Every row containing information about a student represents a record. The records in the student 

table can include fields such as Admission number, Student name, Address, Phone number etc.  

  

2. Queries : used to retrieve information from a database based on specific conditions.  

Ex: A Query can be used to extract details about students studying in a particular class.  

 3. Forms : used as interfaces for users to enter, view and modify data in a 

Table.  

  

4. Reports : used to present data from tables or Queries in a format of our choice. i.e the printable 

form of the table or query or form. We cannot make changes to the data in a report. We can format 

the data in a report.  
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5. Pages : display shortcuts to data access pages in the database. A data access page displays data 

stored in a database over the internet.  

  

6. Macros : used to automate frequently performed tasks. Ex: we can create a macro to print a report 

automatically.  

  

7. Modules : used to perform advanced database operations, such as validating data against complex 

conditions.  

  

  

Creating a Database  

  

(1) Start Access  

(2) Select Blank Database  

(3) In the File Name field enter a name for the database  

(4) Click Create  

  

Microsoft Access automatically creates a new table in the database called Table1. This is a 

temporary name until the table is saved.  

  

Understanding the Views  

  

There are 2 basic views when you work in a table: Design View and Datasheet View. Design View 

is used to set the data types, insert or delete fields, and set the Primary key. Datasheet View is used to 

enter the data for the records. By default, Access places you in Datasheet  view.  

To Switch to Design view:  

(1) Click the View button on the Home Ribbon  

(2) Type a name for the table  

(3) Click OK  

Data types in MS-Access :  

The following list summarizes all the field data types available in MS- Access, their uses and their 

storage sizes.  

➢ Text : used for text or combinations of text and numbers, such as addresses or for numbers that 

do not require calculations, such as phone numbers, or postal codes. Stores up to 255 characters.  

➢ Memo : Used for lengthy text and numbers, such as notes or descriptions. Stores upto 64,000 

characters.  

➢ Number : used for data to be included in Mathematical calculations, except calculations involving 

money. Stores 1,2,4 or 8 bytes.  

➢ Date / Time : used for dates and times. Stores 8 bytes.  

➢ Currency : used for currency values and to prevent rounding off during calculations. Stores 8 

bytes.  

➢ Auto Number : used for unique sequential or random numbers that are automatically inserted 

when a record is added.  
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➢ Yes /No : used for data that can be only one of two possible values, such as yes/ No, True/False, 

On/Off.  

➢ OLE object : used for OLE objects like pictures, graphs and other binary data. Stores up to 1 GB.  

Primary Key  

The field in a table that uniquely identifies each record is called the primary key. Usually this field 

is sequentially numbered. The Primary Key is the unique identifier for each record in a table. Access will 

not allow duplicate entries in a Primary Key field. By default, Access sets the first field in the table as the 

Primary Key field. An example of a Primary Key would be your Social Security Number. This is 

something unique about you and should not be duplicated.  

Entering Data in a Table  

Once you have entered the fields and set the data types it is now time to enter the records in a table.  

To Enter Data in a Table:  

(1) Make sure you are in Datasheet View  

(2) Enter the data into the table by pressing the tab key to move from one cell  

to another  

(3) When you have completed the record (row), press Enter  

  

When inputting data into the table, Access automatically saves the data after each new record Queries 

:  

➢ By using queries we can view, change and analyze data in different ways. You can also use them 

as the source of records for forms and reports.  

➢ You can bring together data from multiple tables and sort it in a particular order.  

➢ You can perform calculations on groups of records.  

Report:  

The data shown in a table, Query and forms are meant for displaying it on screen, but when you 

take the printout or the Hard copy, it is known as Report. In the database window, the open button is 

replaced by the preview button, when you click the report tab. Reports can be viewed either in print 

preview mode or design mode. Data cannot be edited in the reports. The report preview shows how the 

data will appear on taking out the printouts.  

Forms :  

➢ In a table, number of records are displayed at a time. But, if the table has many fields, then it may 

not be possible for a user to view all of them. The screen may be too small to fit it. The user may 

have to scroll horizontally or vertically to view the rest of the fields/ records.  

➢ In forms, the data can be displayed as per the users requirement. The records are generally 

displayed one at a time. The fields can be arranged as the user wants it. Pictures can be added to 

a form. The display and contents of the form is controlled fully by the user.  

➢ In forms there are 3 views,  

i.e. Design ii. Datasheet & iii. Form view  

➢ The datasheet view shows many records whereas form view displays single record. You can 

toggle between these three views using the View Tool.  

ALGORITHM  
Algorithm can be defined as: “A sequence of activities to be processed for getting desired output 

from a given input”.   
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A step by step procedure for solving a particular problem is an Algorithm. To be an algorithm, a 

set of rules must be unambiguous and have a clear stopping point. Algorithms can be expressed in any 

language, from natural languages like English or French to programming languages like FORTRAN, C.  

Before writing an algorithm for a problem, one should find out what is/are the inputs to the 

algorithm and what is/are expected output after running the algorithm. Now let us take some exercises to 

develop an algorithm for some simple problems: While writing algorithms we will use following symbol 

for different operations:   

‘+’ for Addition   

‘-’ for Subtraction   

‘*’ for Multiplication   

‘/’ for Division and   

‘ ’ for assignment. For example A X*3 means A will have a value of X*3.  Example 

of Algorithm   

Problem 1: Find the area of a Circle of radius r.   

Inputs to the algorithm:   

Radius r of the Circle.  

Expected output:  Area 

of the Circle  

Algorithm:   

Step1: Read\input the Radius r of the Circle   

Step2: Area PI*r*r // calculation of area   

Step3: Print Area  

FLOWCHART  

The flowchart is a diagram which visually presents the flow of data through processing systems. 

This means by seeing a flow chart one can know the operations performed and the sequence of these 

operations in a system. Algorithms are nothing but sequence of steps for solving problems. So a flow 

chart can be used for representing an algorithm. A flowchart, will describe the operations (and in what 

sequence) are required to solve a given problem. You can see a flow chart as a blueprint of a design you 

have made for solving a problem.  
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Example: Find the area of a circle of radius   
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     INTERNET  

NETWORK:- Network is group of computers and associated peripherals connected by a communication 

channel, capable of sharing files and other resources between several users.  

INTERNET:- Internet is the abbreviation of International Network. Internet is a network of millions of 

computer machines. The world’s largest computer network consists of 2 million computers.  

SERVER:- server is the computer that access the files, printing, communication or other services 

available to users of the network.  

WWW (World wide Web):- A huge collection of hypertext pages on the Internet is known as World Wide 

Web.  

WEB:- It is a collection of files, document and graphics. This collection made available to others, through 

the Internet is called “Website”.  

WEB BROWSER :- It is a software application. To find something on Internet one has to browse through 

a hypertext document. The browsers automatically access the Internet host that holds the requested 

document.  

HTML ( Hyper Text Markup Language) The coding used to control the look & documents the World 

Wide Web.  

HTTP:- Part of a URL that identifies the location as one that uses HTML.  

URL:- Universal Resource Location- An address of documents and other resources on the web.  

        

How to make your E-mail address:  

Steps:  
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1. Connect computer to the Internet and open the websites e.g. Yahoo.com, Rediff.com, gmail.com 

etc.  

2. Click at the ‘Sign up’ for a free Mail Account. You will get a Form, Fill this Form on the computer 

itself.  

3. Click on ‘I accept’.  

4. After the form is completely filled, click at ‘Sign up’ you will get your E-mail address ready to 

which will be as follows: Your login name @hotmail.Com.  

  

Sending an E-Mail Steps:  

1. Open yahoo.com. You will be asked to enter your login name. (Sign in Name) and password. 

Enter both of them and click at the “Sign up”  

2. You will get the accounts of your e-mail option, like Inbox; compose, etc. on the top of the box 

and the number of new and old message is given on the left hand frame.  

3. Click on compose Button.  

4. Write address of the person.  

5. Typing Message on Big Box.  

6. After completion of your message. Click on send Button. You will get a message after some time.  

7. That your message is successfully sent. Click at “OK” Button.  

8. Click at the back key in the front window menu unless you get the name page of Microsoft.com 

and Exit from Internet connection.  

  

READING MESSAGE  

1. Look at the e-mails after entering appropriate login and password. Now click at the message, 

which you have got as a new message.  

2. A message received is appeared at the monitor. You can read this message and click on ‘Close’ 

key.  

3. Exit from Internet by clicking ‘back’ button several times.  

  

Searching Message  

1. Double Click on Internet Explorer.  

2. Open Google/Yahoo site and login your e-mail.  

3. Click on ‘Search’, different sites are displayed, select and click and read otherwise go for another option 

systematically.  

4. Close by Clicking on ‘Back’ several times.  

Need to take decisions and make critical day-to-day and long-term planning on farm management 

(strategic and tactical).  
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Support have to be relevant, timely, user-friendly to assist and manage crop cultivation. DSS offer 

scientific-technical tools often developed by multidisciplinary teams to combine to skills and 

experience  

  
  

Definition of Decision Supports Systems (DSS)  
DSS are computer-based information systems designed in such a way that help managers to select one of 

the many alternative solutions to a problem. It is possible to automate some of the decision making 

processes in a large, computer-based DSS which is sophisticated and analyze huge amount of information 

fast. It helps corporate to increase market share, reduce costs, increase profitability and enhance quality. 

The nature of problem itself plays the main role in a process of decision making. A DSS is an interactive 

computer based information system with an organized collection of models, people, procedures, software, 

databases, telecommunication, and devices, which helps decision makers to solve unstructured or 

semistructured business problems.   

Concept and Meaning of DSS  
A Decision Support System (DSS) is an interactive, flexible, and adaptable computer based information 

system that utilizes decision rules, models, and model base coupled with a comprehensive database and 

the decision maker’s own insights, leading to specific, implementable decisions in solving problems that 

would not be amenable to management science models. Thus, a DSS supports complex decision making 

and increases its effectiveness.  

Characteristics of DSS  
• Handle large amounts of data like database searches   

• Obtain and process data from different sources including internal and external data stored on 

mainframe systems and networks   

• Provide report and presentation flexibility to suit the decision maker's needs   

• Have both textual and graphical orientation like charts, trend lines, tables and more  

• Perform complex, sophisticated analysis and comparisons using advanced software packages.  

• Support optimization, satisfying, and heuristic approaches giving the decision maker a great deal 

of flexibility in solving simple and complex problems  Perform "what-if" and goal-seeking 

analysis.  

  

Components of Decision Support System  

A DSS application can be composed of following subsystems   

1. Data Management subsystem  

 The database management subsystem includes a database, which contains relevant data for the situation 

and is managed by software called the database management system (DBMS). The database management 

subsystem can be interconnected with the corporate data warehouse, a repository for corporate relevant 

decision-making data.   

  

2. Model Management subsystem  

The model base gives decision makers access to a variety of models and assist them in decision making. 

The model base can include the model base management software (MBMS) that coordinates the use of 

models in a DSS. This component can be connected to external storage of data.   

3. Knowledge-based Management subsystem   
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This subsystem can support any of the other subsystem or act as an independent component. It provides 

intelligence to augment the decision maker’s own. It can be interconnected with the organization’s 

knowledge repository, which is called the organizational knowledge base.   

4. User Interface subsystem   

The user interface, also called the dialog management facility, it allows users to interact with the DSS to 

obtain information. The user interface requires two capabilities; the action language that tells the DSS 

what is required and passes the data to the DSS and the presentation language that transfers and presents 

the user results. The DSS generator acts as a buffer between the user and the other DSS components, 

interacting with the database, the model base and the user interface.  

 
Figure 1: A Schematic view of DSS highlighting different components  

  
Some tools for Decision Support System  

Agricultural decision makers at all levels need an increasing amount of information to better understand 

the possible outcomes of their decisions and to assist them in developing plans and policies that meet 

their goals.   

1. Decision Support System for Agrotechnology Transfer (DSSAT)  

An international team of scientists has recently developed a decision support system for agrotechnology 

transfer (DSSAT) to estimate production, resource use, and risks associated with different crop production 

practices. The Decision Support System for Agro-technology Transfer (DSSAT) Version is a software 

application program that comprises crop simulation models for over 42 crops (as of Version 4.6). For 

DSSAT to be functional it is supported by data base management programs for soil, weather, and crop 

management and experimental data, and by utilities and application programs. The crop simulation 

models simulate growth, development and yield as a function of the soil-plant-atmosphere dynamics. 

DSSAT and its crop simulation models have been used for many applications ranging from onfarm and 

precision management to regional assessments of the impact of climate variability and climate change. It 

has been in use for more than 20 years by researchers, educators, consultants, extension agents, growers, 

and policy and decision makers in over 100 countries worldwide. The crop models require daily weather 

data, soil surface and profile information, and detailed crop management as input. Crop genetic 
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information is defined in a crop species file that is provided by DSSAT and cultivar or variety information 

that should be provided by the user. Simulations are initiated either at planting or prior to planting through 

the simulation of a bare fallow period. These simulations are conducted at a daily step and, in some cases, 

at an hourly time step depending on the process and the crop model. At the end of the day the plant and 

soil water, nitrogen and carbon balances are updated, as well as the crop’s vegetative and reproductive 

development stage. For applications, DSSAT combines crop, soil, and weather data bases with crop 

models and application programs to simulate multi-year outcomes of crop management strategies.  

Concept contingent crop-planning in Agriculture  

Contingency plan can be defined as a plan aimed and executed for an outcome other than in the usual or 

expected plan. In other words, it is frequently used for risk management when an exceptional risk in 

future. In general, the change in sowing or planting time of crops, change in seed rate, change in schedule 

of fertilizer use, use of short duration varieties, improved crop genotypes form the core component of 

contingency crop planning. In case of cyclone and its associative flood events, we may recommend use 

of water logging tolerant rice varieties such as Varshadhan, Hanseswari, Durga for better resilience. 

However, in case of flash floods, the use of swarna sub-1 should form the core component of contingency 

plan. Similarly, the use of over aged rice seedlings of 45 days and 60 days old are recommended for 

cyclone and flood prone areas. The development of community nursery and seed bank is critical in supply 

of seedlings of rice in case of cyclone damage. At least seed bank should be developed for 10% of the 

area under each block which can be utilized for transplanting in post cyclone period.  

Preparation of contingent crop-planning using IT tools  

  

Contingency  crop plans cover contingency strategies to be taken up by farmers in response to major 

weather related aberrations such as delay in onset and breaks in monsoon causing early, mid and late 

season droughts, floods, unusual rains, extreme weather events such as heat wave, cold wave, frost, 

hailstorm and cyclone.   

Online Crop Contingency Planning (CRIDA) http://www.crida.in:82/contingencyplanning/  

Users can access this Online Contingency Crop Planning to extract relevant information at the district 

level for a selected contingency situation. This decision support system presents the operational part 

related to crop planning in the face of prevailing aberrant weather situations and draws extensively from 

the country-wide effort by CRIDA in collaboration with 46 State Agricultural Universities and 7 ICAR 

institutes in preparing “District level Contingency Plans” covering crop, horticulture, livestock, poultry 

and fisheries sectors. The major farming situations, crops and their sowing windows for a normal 

monsoon prevalent on selection of a district of interest are displayed as a default.  As a first step, users 

can access this web interface to know suggested contingency measures related to drought due to delay in 

monsoon onset and breaks in monsoon. Suggested contingency measures depend on the extent of delay 

in monsoon and could be change in crop or change in cultivar in place of the normal crop in a given 

farming situation. Appropriate agronomic measures are suggested in case of early, mid and late season 
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droughts. Contingencies for other key weather related contingencies such as floods, unseasonal rains and 

extreme weather events are being added.     
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IT APPLICATION FOR COMPUTATION OF WATER & NUTRIENT   

REQUIREMENTS OF CROPS  

 The water requirement of crops is the amount of water that is required to meet the evapo-transpiration 

rate so that crops may thrive. The evapo-transpiration rate is the amount of water that is lost to the 

atmosphere through the leaves of the plant, as well as the soil surface.  

Therefore, in order to estimate the water requirement of a crop we first need to measure the 

evapotranspiration rate. The reference rate, ET0, is the estimate of the amount of water that is used by a 

wellwatered grass surface that is roughly 8 to 15 centimetres in height. Once ET0 is known, the water 

requirement of the crop can be calculated.  

    METHODS TO MEASURE THE EVAPOTRANSPIRATION RATES OF CROPS  

There are at least two methods that can be used to measure or predict the evapo-transpiration rate of 

crops:   

1. Evaporation pan  

2. Using equations that predict the evapo-transpiration rate based on climatic parameters.  

  

1. EVAPORATION PAN  

In this method, pan is filled with water and the loss of water from the pan is measured. Provided that 

there is no rainfall, the evaporation rate, which is recorded as millimetres per day, is quite easy to measure. 

This method of measurement takes into account wind, temperature, radiation and humidity, which are the 

same factors that affect crop transpiration rate.  

However, there are a few factors that prevent this recording from being entirely accurate. For one, 

the solar radiation results in heat storage in the pan. This can lead to increased reading of the evaporation 

rates at night, when transpiration usually does not occur. In addition, temperature and humidity levels 

above the pan surface will vary from what would naturally occur.  

  

                                                          Evaporation Pan  

In this method, different kinds of pans are used to measure the water requirements of crops, with Kp 

representing the pan coefficient, according to the kind of pan, solar radiation, wind, humidity and the 

surroundings.  

 ETo = Kpan × Epan  
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2. THE PENMAN-MONTEITH EQUATION  

The reference rate, ET0, is calculated using the Penman Equation, which takes into account the climatic 

parameters of temperature, solar radiation, wind speed and humidity.  

A variation of this equation, given by the FAO is:  

    

 Where  

 ET0 reference evapo-transpiration [mm day-1],  

Rn net radiation at the crop surface [MJ m-2 day-1],  

G soil heat flux density [MJ m-2 day-

1], T air temperature at 2 m height 

[°C], u2 wind speed at 2 m height [m 

s-1], es saturation vapour pressure 

[kPa], ea actual vapour pressure 

[kPa],  

es - ea saturation vapour pressure deficit 

[kPa], D slope vapour pressure curve [kPa 

°C-1], g psychometric constant [kPa °C-1].  

  

3. THE BLANEY-CRIDDLE EQUATION  

Another method of calculating the reference crop evapo-transpiration, ET0.  

ETo = p (0.46 T mean + 8)  

ETo = Reference crop evapo-transpiration 

(mm/day) Tmean = mean daily temperature (°C) p = 

mean daily percentage of annual daytime hours.  

As we can notice from the equation above, this method takes into account only the measurement of 

temperature. Therefore, it is not a very accurate estimation of the reference evapo-transpiration rate.  

   

ESTIMATING THE WATER REQUIREMENTS OF THE CROP  

ET0 represents the maximum, or potential, evapo-transpiration rate that can occur. However, the water 

requirement of the crop is usually less than ET0, as there are factors of the crop itself that have to be taken 

into account.  
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These include the growth stage of the plant, the leaf coverage that provides shade to the ground, 

and other particulars of the crops that make them vary from each other. With these factors taken into 

account, ET0 is converted into ETc, through the crop-specific coefficient, Kc.  

 ETc represents the evapo-transpiration rate of the crop under standard conditions (no stress conditions).  

When calculating ETc, one must identify the growth stages of the crop, their duration and select the 

proper Kc coefficient that need to be used.  

 ETc = Kc * ET0.  

   

  

Climatic effects are incorporated into ET0, while the effects of the crop characteristics are incorporated 

into Kc.  

 EXAMPLE FOR CALCULATING THE WATER REQUIREMENT OF A CROP  

Crop: potato  

Growth stage: Initial growth  

Kc for initial stage: 0.45  

ET0 (measured by a local meteorological station): 9 mm/day  

   

ETc = Kc * ET0  =  0.45 X 9 = 4.05 mm/day   

Note: Calculation has been done by SMART! Fertilizer Management software and an international 

expert in plant nutrition and irrigation.  

A Computer program for Calculating Crop Water Requirements  

A computer program was developed for determination of crop water requirements using local 

meteorological and research data, and also using Visual Basic 6.0 Programming language. For 

verification of the model, field trials were carried out during the period December 2007 – July 2008 at 

four schemes using centre-pivot irrigations in the northern parts of Sudan. The program was based on 

using Penman equation and Penman-Monteith method. Results were comparable to those obtained 

through traditional time-consuming methods. The program could offer a simple tool for planning crop 

water requirements for agricultural projects.  
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The programming language of Visual Basic, version 6.0 was used to develop the program for 

calculating crop water requirements using the modified Penman equation and the Penman-Monteith 

method. It was based on five flow charts. The first chart is a welcoming screen and loads the database for 

the program (Fig.1). The other four flow charts calculate ET0, Kc and ETC using the modified Penman 

equation or the Penman-Monteith method according to the choice of the user (Fig.2, Fig.3 and Fig.4).   

  

  

  

Figure 1: Main Window  
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   Figure 2: Crop water requirement (Penman-Monteith)  

  
   Figure 3: Crop water requirement (Modified Penman)  
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Figure 4: Agro-meteorological Data (Sample Data)  
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INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) 

APPLICATIONS IN AGRICULTURE  

Information and communications technology (ICT) is an extended term for information technology (IT) 

which stresses the role of unified communications and the integration of telecommunications (telephone 

lines and wireless signals), computers as well as necessary enterprise software, middleware, storage, and 

audio-visual systems, which enable users to access, store, transmit, and manipulate information.   

The term ICT is also used to refer to the convergence of audio-visual and telephone networks with 

computer networks through a single cabling or link system. There are large Coyme Boang incentives 

(huge cost savings due to elimination of the telephone network) to merge the telephone network with the 

computer network system using a single unified system of cabling, signal distribution and management.   

However, ICT has no universal definition, as "the concepts, methods and applications involved in ICT 

are constantly evolving on an almost daily basis." The broadness of ICT covers any product that will 

store, retrieve, manipulate, transmit or receive information electronically in a digital form, e.g. personal 

computers, digital television, email, robots. For clarity, Zuppo provided an ICT hierarchy where all levels 

of the hierarchy "contain some degree of commonality in that they are related to technologies that 

facilitate the transfer of information and various types of electronically mediated communications.” Skills 

Framework for the Information Age is one of many models for describing and managing competencies 

for ICT professionals for the 21st century.   

ICT in Agriculture   

ICT is a vital tool for and instantly transferring the technologies. Timely and instant advisory on pest and 

disease control, fore-warning on weather and climate conditions, market information support, price 

forecast could help the farmers in day to day farm operations. The source and availability of inputs and 

direct interaction with experts provide ample opportunity to farmers updating. Besides computer, mobile 

and social networks like blogs, face book and twitter could be used as better platform for technology 

delivery and advisory. The agri knowledge portals, video conference facility, expert systems etc offer 

immense scope for the 21st century.  

 ICT in Agriculture   

ICT is a vital tool for and instantly transferring the technologies. Timely and instant advisory on pest and 

disease control, fore-warning on weather and climate conditions, market information support, price 

forecast could help the farmers in day to day farm operations. The source and availability of inputs and 

direct interaction with experts provide ample opportunity to farmers updating. Besides computer, mobile 

and social networks like blogs, face book and twitter could be used as better platform for technology 

delivery and advisory. The agri knowledge portals, video conference facility, expert systems etc offer 

immense scope for effective and instant transfer of technology and ensure timely expert advisory. How 

to prepare the extension workers and farmers associations and farmers for this kind of e-extension?   

ICT application in agriculture is at its infancy compared to other sectors. Knowledge portal, weather 

forecast, dynamic market information, interactive multimedia and above all, the twitters, face book and 

google + social networks could also be best utilized as knowledge sharing plat form, mobile plat form 

offers instant agro advisory to individual farmers. The research and development on ICT in agriculture is 

yet to begin. The various ICT and mobile platform options are to be evaluated, standardized and 

customized for immediate use. The navigation friendly modules are to be creatively designed and tested 
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for efficiency in dissemination of technology. The technology use efficiency could be enhanced by 

undertaking research and development in ICT initiatives in Agriculture.   

New Media Tools   

New Media Tools are methods of interactive communication that rely upon a computer or mobile device 

with Internet access. New media tools allow the creation, publication, modification and distribution of 

information using simple tools. Among the most popular tools used to share content are text messaging, 

blogs, social networks, podcasts and RSS feeds.   

New media most commonly refers to content available on-demand through the Internet, accessible on 

any digital device, usually containing interactive user feedback and creative participation. Common 

examples of new media include websites such as online newspapers, blogs, or wikis, video games, and 

social media. A defining characteristic of new media is dialogue. New Media transmit content through 

connection and conversation. It enables people around the world to share, comment on, and discuss a 

wide variety of topics. Unlike any of past technologies, New Media is grounded on an interactive 

community.   

Most technologies described as "new media" are digital, often having characteristics of being 

manipulated, networkable, dense, compressible, and interactive. Some examples may be the Internet, 

websites, computer multimedia, video games, augmented reality, CD-ROMS, and DVDs. New media are 

often contrasted to "old media," such as television, radio, and print media, although scholars in 

communication and media studies have criticized rigid distinctions based on oldness and novelty. New 

media does not include television programs (only analog broadcast), feature films, magazines, books, or 

paper-based publications – unless they contain technologies   

that enable digital interactivity. Wikipedia, an online encyclopedia, is an example, combining Internet 

accessible digital text, images and video with web-links, creative participation of contributors, interactive 

feedback of users and formation of a participant community of editors and donors for the benefit of 

noncommunity readers. Face book is an example of the social media model, in which most users are also 

participants. Wikitude is an example for augmented reality. It displays information about the users' 

surroundings in a mobile camera view, including image recognition, 3D modeling and location-based 

approach to augmented reality.   

Mobile Phones and Mobile Apps   

The Government has the mandate to make the Second Green Revolution happen in agriculture sector by 

transforming it as the people movement. The key and vital strategy to materialize this kind of massive 

mandate is the effective transfer of technology, which in turn to enhance the input use efficiency and 

technology use efficiency. The current methods of transfer of technology through mass media print media 

and e- media aim to disseminate the technology across the mass and not focused enough to address the 

individual farm based day-to-day operational issues related to the crop in question.   

The day-to-day field problems are specific to each farmer and for each crop stage and situation. Any 

individual advisory without taking into account the effects of climate change also becomes irrelevant 

now a day in as much as the climate fluctuations are rampant and affects the crop growth irrespective of 

the stage. The dissemination of individual technology also does not serve the purpose, as the farmers are 

unable to distinguish the cumulative effects’ of elemental toxicity, deficiency, pest and disease infection 

or abiotic stress.   
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With the introduction of high-end technologies and advanced cultivation systems, the field problems are 

compounding necessitating individual farm based agro advisory to the farmers to undertake all the 

operations in time and maximize the productivity. Particularly small to medium farmers face a critical 

situations as they are not having any immediate access to information and require decision support for 

using modern agricultural techniques and practices.   

The issues like what to grow? how to select appropriate inputs, where to access for credit support? How 

to get the cultural tips every day, where to sell? are unanswered as on date. The problems are different 

for different farmers as each farm has its own pre-requisites. Moreover   

each farm has a unique input and output history and geo-physical characteristics. What is needed is an 

interaction between farmers who already have an intimate knowledge of their own Farm Plot and modern 

agricultural scientists and workers for a farm specific advisory in real time.   

Both on-line and off-line based ICT-A techniques have lot of impact on the research system and extension 

systems. But, the user system is facing lot of hurdles to access computer based advisory system. Mobile 

based technology advisory platform will overcome the problems on connectivity (last-mile), accessibility, 

timely advice and reach faced by the end users. At the same time mobile have multimedia / multiple 

options such as Text, Voice, Images and Video clippings which can be transmitted to the farmer and 

possibility of receiving the feed-back   

A mobile app is a software application developed specifically for use on small, wireless computing 

devices, such as smart phones and tablets, rather than desktop or laptop computers.   

Keeping the fast change in technology delivery and transfer system, it is time to everyone has to 

understand various tools in front of us and try use it for effective education and communication purpose.   

Important ICT initiatives and its application in India   

Farmer Portal-Government of India Initiative (http://www.farmer.gov.in)   

It is envisaged to make available relevant information and services to the farming community and private 

sector through the use of information and communication technologies, to supplement the existing 

delivery channels provided for by the department. Farmers’ Portal is an endeavor in this direction to 

create one stop shop for meeting all informational needs relating to Agriculture, Animal Husbandry and 

Fisheries sectors production, sale/storage of an Indian farmer. With this Indian Farmer will not be required 

to sift through maze of websites created for specific purposes.   

Once in the Farmers’ Portal, a farmer will be able to get all relevant information on specific subjects 

around his village/block /district or state. This information will be delivered in the form of text, SMS, 

email and audio/video in the language he or she understands. These levels can be easily reached through 

the Map of India placed on the Home page. Farmers will also be able to ask specific queries as well as 

give valuable feedback through the Feedback module specially developed for the purpose.   
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mKisan Portal (http://mkisan.gov.in)   

Short Message Service (SMS) Portal was inaugurated by the Hon’ble President of India on July 16, 2013 

and since its inception nearly 50 crore messages or more than 152 crore SMSs have been sent to farmers 

throughout the length and breadth of the country. These messages are specific to farmers’ specific needs 

& relevance at a particular point of time. These messages generate heavy inflow of calls in the Kisan Call 

Centres where people call up to get supplementary information.   

SMS Portal for Farmers has empowered all Central and State Government Organizations in Agriculture 

& Allied sectors (including State Agriculture Universities, Krishi Vigyan Kendras, Agromet Forecasts 

Units of India Meteorological Department, ICAR Institutes, Organization in Animal Husbandry, Dairying 

& Fisheries etc.) to give information/services/advisories to farmers by SMS in their language, preference 

of agricultural practices and locations. To put it succinctly, almost every Government Department, office 

and Organization from the Ministry Headquarters down to the level of Block having anything to do with 

agriculture and allied sectors in every nook and corner of the country has been authorised to use this 

Portal to provide information to farmers on vast gamut of issues.   

  
USSD (Unstructured Supplementary Service Data), IVRS (Interactive Voice Response System) and Pull 

SMS are value added services which have enabled farmers and other stakeholders not only to receive 

broadcast messages but also to get web based services on their mobile without having internet. 

Semiliterate and illiterate farmers are also targeted to be reached by voice messages.   
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Objectives of the Portal include:   

 To make SMS and other mobile based services as a tool of 2 way agricultural extension in which not 

only information/advisory services are provided to farmers as per his/her need in a broadcast mode (in 

keeping with selection of crop / agricultural practice, requirements and location) but they can also raise 

specific queries through Pull SMS or USSD.   

 Making use of huge spread of mobile telephony in the rural areas to cover every farm household in the 

country to overcome the major impediment in bringing level playing field for small and marginal farmers. 

Presently, there are about 38 crore mobile telephones in rural areas as against nearly 9 crore farm 

households.   

 Centralized system wherein different modes of information flow are channelized and spread to the 

farmers in their own language.   

 Integrated Portal to ensure proper storage in previous advisories/messages and also effective 

monitoring at various levels.   

 Integration of database of farmers from the State Governments, Universities, KVKs web based 

registration, Kisan Call Centres etc.   

 Since effective internet penetration in the rural areas is about 5% only, text messaging in the language of 

the farmer transcends the barriers of digital divide.   

 Provision of web based services through SMS or USSD is thus the fulcrum of the whole Project.   

 Integration with other farmer-centric services such as Kisan Call Centres, Common Service Centres, 

Web Portals for extracting relevant information and also for feeding data from remote locations where 

Internet is not available or is unreliable.   

AGMARKNET (http://www.agmarknet.nic.in)   

AGMARKNET is a Central Sector Scheme to network Agricultural Produce Wholesale Markets 

(APWMS), State Agricultural Marketing Boards/Directorates and DMI Regional Offices to collect 

agricultural produce price/arrival information and dissemination. Agmarknet portal is accessible to all 

stakeholders through internet access. e-Alert is a method to facilitate and access agricultural produce 

price of market information by the public through E-mail/SMS.   
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e-National Agriculture Market (e-NAM) http://www.enam.gov.in   

National Agriculture Market (NAM) is a pan-India electronic trading portal which networks the existing 

APMC mandis to create a unified national market for agricultural commodities.   

The NAM Portal provides a single window service for all APMC related information and services. This 

includes commodity arrivals & prices, buy & sell trade offers, provision to respond to trade offers, among 

other services. While material flow (agriculture produce) continue to happen through mandis, an online 

market reduces transaction costs and information asymmetry.   

Agriculture marketing is administered by the States as per their agri-marketing regulations, under which, 

the State is divided into several market areas, each of which is administered by a separate Agricultural 

Produce Marketing Committee (APMC) which imposes its own marketing regulation (including fees). 

This fragmentation of markets, even within the State, hinders free flow of agri commodities from one 

market area to another and multiple handling of agri-produce and multiple levels of mandi charges ends 

up escalating the prices for the consumers without commensurate benefit to the farmer.   

NAM addresses these challenges by creating a unified market through online trading platform, both, at 

State and National level and promotes uniformity, streamlining of procedures across the integrated 

markets, removes information asymmetry between buyers and sellers and promotes real time price 

discovery, based on actual demand and supply, promotes transparency in auction process, and access to 

a nationwide market for the farmer, with prices commensurate with quality of his produce and online 

payment and availability of better quality produce and at more reasonable prices to the consumer.   
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TNAU AGRITECH PORTAL (http:// agritech.tnau.ac.in)   

Agritech Portal is a new initiative by e-Extension Centre of Directorate of Extension Education, Tamil 

Nadu Agricultural University to eliminate the communication gap between the University scientists, 

agriculture officials and farmers. Agritech portal transfer the agriculture related information and new 

technologies to the farmers and extension officials. Accordingly, increase the livelihood of the farmers 

and update the knowledge of extension officials. The farmers will be able to acquire the information 

without the help of the experts. Also, they discuss with scientists and experts through video conferencing 

technology.   

This dynamic portal holds around nine lakh pages in Tamil and English with multiple media content. The 

Portal (http://agritech.tnau.ac.in) has been dedicated to service on 27th Sep, 2009 for the benefit of field 

extension officials and other stakeholders. As on date, the daily visitors are 3,000-6,000 (approximately), 

average time on site 24-32 minutes, Number of page hits / day 240-290 pages, e-Mail Queries 35,000, 

New visitors / day 700-920 (approximately) and updation is on daily basis. Currently, the Government of 

Tamil Nadu has taken-up the portal initiative as flagship programme under National e-Governance and 

Tamil Nadu State e-Governance to share all developmental programmes for the well-being. TNAU 

agritech portal   

has also been awarded the ‘Best e-governance agri portal’ by Government of India twice 2010-11 and 

2014-15 respectively.   



48  

  

  

 

AGRIFAIR PORTAL (https://www.agrifair.in/) 

Agrifair website is developed Providing Pdf Books and Notes, Agriculture Dictionary, Current Affairs, Quiz, 

Facts, Career And Course Videos and Article, Business Idea, Review and Interview, Farm machinery Videos, 

Field visits video, practical/Lab work, experiment, Methods and preparation Tips, Farming idea, varities and  

Diseases, pests and it’s prevention. All Agricultural Exams Update like IBPS-AFO, FCI, ICAR, JET, NET, 

JRF, SRF, NSC, and State Agriculture exams. Notification About:- jobs/vacancy. And All About Agriculture 

Related Things. 

You can visit this website for knowledge of anything related to Agriculture, you can also visit it’s youtube 

portal for the same type of knowledge as stated above  but in the form of videos. 

 

Expert System in Agriculture   

An Expert System (ES), also called a Knowledge Based System (KBS), is a computer program designed 

to simulate the problem-solving behavior of an expert in a narrow domain or discipline. The expert system 

could be developed for decision-making and location specific technology dissemination process. An 

expert system is software that attempts to reproduce the performance of one or more human experts, most 

commonly in a specific problem domain, and is a traditional application and/or subfield of artificial 

intelligence. Expert system helps in selection of crop or variety, diagnosis or identification of pests, 

diseases and disorders and taking valuable decisions on its management. The expert systems developed 

earlier were more of text based and could be utilized only by the extension officials and scientists. Expert 

system for agriculture (Paddy, Sugarcane, Banana, Ragi and Coconut) and animal husbandry for the three 

states in their respective languages i.e., Tamil Nadu (Tamil), Karnataka (Kannada) and Kerala 

(Malayalam) was developed.   

  

Expert System   

http://www.agrifair.in/
https://www.youtube.com/channel/UCT8Y0gi8OMrewzGuOEbzNpg
https://www.youtube.com/channel/UCT8Y0gi8OMrewzGuOEbzNpg
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The expert system was designed and developed to serve the farming community, extension workers, 

scientists and other stakeholders. The home page of the expert system has three important components, 

which are   

1. Information System   

2. Decision Support System,   

3. Diagnosing System (Crop Doctor)   

Information System   

Information system is web based static information wherein all the technological information and 

complementary information about the crop have been loaded in this component. The validated contents 

and images have been organized based on the package of practices. Special feature of the information 

system is user-friendly navigation with image-based presentation.   

The static information system is highly useful for the extension officials, scientists, and policy makers 

and administers as ready reference material and bibliography of concerned crop. This content can be 

updated dynamically then and there based on the advancement of the technologies.   

  

Decision Support System (DSS)   

Decision support systems are a class of computer-based information systems including knowledge-based 

systems that support decision-making activities. DSS is a computerized system for making decisions. A 

decision is a choice between alternatives based on estimates of the values of those alternatives. 
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Supporting a decision means helping farmers working alone or in a group gathers intelligence, generate 

alternatives and make choices.   

Accordingly, the DSS has been contemplated and designed to get best possible options and decision by 

farmer themselves for the day today agriculture operation. Drop down formula or multiple combo boxes 

have been created using simple dot net programme. Each box in the DSS is correlated with each one for 

retrieving the best possible decision support for crop cultivation.   

Key features of the DSS:   

01. User friendly navigation   

02. Image and Video based information, so even illiterate can use this system and get image-based 

information.   

03. Instant decision support for key information crop production technologies, which can facilitate the 

farmers to take quick decision in crop cultivation activities.   

04. Automatic calculation of nutrient requirement for different stage of crops based on the soil, water and 

other parameters.   

05. Scientific information about the crop, botanical characteristics, varietal characteristics with images 

are added features in the DSS  rop Doctor:   

Crop doctor is a vital component in the expert system, which act as artificial intelligence. It is picture and 

image based ‘if and then rule’ based programme which has written using dot net programme. It deals 

with diagnosing the pest, disease and nutritional disorders affecting the selected crops. The first obvious 

sign is given as thumbnail images in the Key Visual Symptoms (Primary Symptom) with multiple stages 

(Secondary Symptoms). Primary and secondary symptoms have been documented in stage-by-stage and 

loaded in the expert system shell by using if and then rule based programme. The concerned experts have 

validated all the symptoms, which loaded in the expert system shell.   

Domestic and Export Market Intelligence Cell   

Domestic and Export Market Intelligence Cell was established in CARDS, TNAU to disseminate real 

time price information and domestic and export market intelligence on agricultural commodities for better 

scientific decision-making by farming community, traders, firms and researchers. This project was funded 

by Department of Agricultural Marketing and Agribusiness, Government of Tamil Nadu. Price forecasts 

were made for major crops well in advance of sowing seasons which include the anticipated prices during 

harvest of these crops, quality standards to get higher prices, markets offering highest prices, market 

offering highest prices etc. Again during harvest of these crops recommendations are made whether to 

store the produce or not and the duration of storage for getting maximum prices.   

  

How to access the DEMIC information?   

An exclusive website has been created for DEMIC both in English and Tamil with help of National 

Informatics Centre, Chennai for dissemination market information (www.tnagmark.tn.nic.in). Also it can 

be accessed through website (http://www.tnau.ac.in/cards/demic.html) and through AMIS webpage.   

Kisan Call Center: 1800-180-1551   
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In order to harness the potential of ICT in Agriculture, Ministry of Agriculture launched the scheme 

"Kisan Call Centres (KCCs)" on January 21, 2004. Main aim of the project is to answer farmers' queries 

on a telephone call in their own dialect. These call Centres are working in 14 different locations covering 

all the States and UTs. A countrywide common eleven digit Toll Free number 1800-180-1551 has been 

allotted for Kisan Call Centre. This number is accessible through mobile phones and landlines of all 

telecom networks including private service providers. Replies to the farmers' queries are given in 22 local 

languages.   

Call center services are available from 6.00 am to 10.00 pm on all seven days of the week at each KCC 

location. Kisan Call Centre agents known as Farm Tele Advisor(FTAs), are graduates or above (i.e. PG 

or Doctorate) in Agriculture or allied (Horticulture, Animal Husbandry, Fisheries, Poultry, Bee-keeping, 

Sericulture, Aquaculture, Agricultural Engineering, Agricultural Marketing, Bio-technology, Home 

Science etc. and possess excellent communication skills in respective local language.   

A Kisan Knowledge Management System (KKMS) to facilitate correct, consistent and quick replies to 

the queries of farmers and capture all the details of their calls, has been developed. Kisan Knowledge 

Management System (KKMS) has its independent web site http://dackkms.gov.in. The Kisan Call Centre 

(KCC) Agents working at various KCC locations throughout the country have access to this web site 

through their specific ID's & Pass-Word provided to them.   

Levels of KCC:   

The Kisan Call Center, consists of three levels namely Level-I (the basic Call Center interface, with high 

quality bandwidth and local language proficient Agriculture Graduate), Level-II (Subject Matter 

Specialists on concerned important crops and enterprises, connected through good bandwidth telecom 

and computer connectivity) and Level-III (the Management Group to ensure ultimate answering and 

resolution of all the farmers queries which are not resolved at Level-II, connected on off line mode).   

Level - I: The call coming to the call center is picked up by an operator (level I functionary) who after a 

short welcome message takes down the basic information and the query of the caller. These details are 

fed into a computer located next to the operator by the operator himself. And the first level receiver of 

the call would also feeds into the computer the question being asked by the farmer.   

The first level operators preferably would be an agricultural graduate with rural background knowing 

local language. They should also possess good communication skills. They would be in a position to 

answer a majority of the questions likely to be asked by the farmers.   

Level - II: The level -II consists of Subject Matter Specialists (SMS) who are located at their respective 

place (Research Stations, ATICs, KVKs, Agricultural colleges), of work. In case the first level operator 

is not able to answer the question, the operator forwards (in call sharing mode) the call to the concerned 

Subject Matter Specialist. The data relating to the caller including the question asked is also be transferred 

to the Level-II functionary on his computer along with the call. Hence, when the specialist takes the 

forwarded call, his computer also shows the data and question asked so that there is no repetition. It is 

envisaged that in normal cases, the entire spill over questions from the first level get answered at this 

level. In case, it is not possible to answer, there is a system to revert back to the caller by post / fax / email 

or by telephone in 72 hours.   

Level - III: The level - III consists of a dedicated cell located at the Nodal Office. This would receive the 

questions that have not been answered at the first and the second levels. Appropriate replies to these 
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questions would be then framed in consultation with the concerned specialists available within or outside 

the State, by the nodal cell. The replies would be sent to the farmers promptly by post/e-mail/fax/ 

telephone etc. within 72 hours of receipt of the question   

KSeva -- Since most of these services are web-based, an interface has been developed to send the 

results/reports of various services on mobile phone of the farmers with a 6 digit short code KRISHI. The 

service can be easily integrated with the existing national Kisaan SMS Portal. With this all SMSs will be 

sent to the farmers without any cost to the department concerned. These   

transactions will also be included in the e-Taal portal of Department of Electronics and information 

Technology (DeitY), Government of India, which counts electronic transactions happening through 

various online services of both State and Central Government applications.   

State Governments and all other departments may start using KSeva for providing services in an 

efficacious and pervasive manner. Methodology of linking service to Kisaan SMS Portal is detailed as 

under:   

1. The  Department/Organization  concerned  registers  on  URL 

http://mkisan.gov.in/ksewa/registrationForm.aspxthrough a designated officer.   

2. This officer is to be authorized by Head of the Department or Organization. Scanned copy of such 

authorization needs to be uploaded on registration interface.   

3. The administrator of the Portal will approve after making such verification as may be deemed 

necessary.   

4. The User ID and Password chosen by the Registering Officer will be used for logging into the 

service. The password can be changed as often as required.   

5. While approving the registration request, Authentication Code for Integration will be sent to the 

end user by e-mail and SMS. The service can be linked with the Kisaan SMS Portal using the 

authentication code downloaded. Technical documents for integration of service have been prepared for 

C# and JAVA and the same are available under "How to Integrate" tab. You can access this tab after login.   

6. White-listing of the server where application is hosted with Kisaan SMS Portal is required to be 

done. White-listing will be allowed on this end only when complete security audit of the application to 

be linked has been done.   

  

Interactive Voice Response System (IVRS) -- Interactive Voice Response System (IVRS) is an automated 

telephony system that interacts with callers, gathers information and routes calls to the appropriate 

recipient. An IVR application provides pre-recorded voice responses for appropriate situations, keypad 

signal logic, access to relevant data and potentially the ability to record voice input for later handling. 

Using computer telephony integration (CTI), IVR applications bring in efficiency in terms of call 

handling. Generally an IVR system consists of telephony equipment, software applications, a database 

and the supporting infrastructure.   

Outbound Calls – These are used for obtaining feedback of farmers regarding the advisories they are 

receiving from experts and also on the quality of information being given to them by KCC agents. A 
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farmer can rate the advisory or answer given by KCC agent on the scale of 1 to 5. This service is available 

in 12 different Indian Languages.   

Inbound Calls - Farmers or all other stakeholders can call this number (022-67870177) for giving useful 

feedback on the services or for obtaining any information from a predefined menu.   

Agricultural Information Service Network (AGRISNET) (www.tnagrisnet.tn.gov.in)   

Government of India sponsored AGRISNET project is being implemented in throughout India by the 

respective State Department of Agriculture. Tamil Nadu model is unique. Hereby it is shared the 

initiatives of Tamil Nadu since 2007-08. The objective of the Web portal is to deliver all Agricultural 

Information services to the farming community. The website www.tnagrisnet.tn.gov.in has been officially 

launched during July, 2010.   

  

New Initiatives taken in AGRISNET portal   

Farm Crop Management System   

Main objective of Farm Crop Management System is bringing Second Green Revolution by using the 

power of Information Technology to empower and enable the farmers to get three fold increases in the 

farm income in next five years through developing micro level farm plan   

and executing it by the Agriculture, Horticulture, Agricultural Engineering and Agriculture Marketing 

Departments. Following are the IT initiatives taken by the Department.   

• Implementation of FCMS (Farm Crop Management System) by using Hand held Tablet PC device, 

PICO Projector and Touch Screen kiosks.   

• Voice enabled extension services   

• Farmer Data updation through Mobiles   

• Touch screen kiosks for information access   

• Farm machinery rental system by IVRS   

• Electronic billing for enabling online input availability status   

• Agro advisories through voice and Text SMS mode   
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• Scheme Benefit Tracking System   

  

Collection of Individual Farmer data regarding personal, Contact, Bank, land and other various resources 

available at farm holding is the first process of Farm Crop Management System (FCMS).   

The villages are categorized into micro climate zones and farm level plans will be developed by 

considering the factors like soil, irrigation and rainfall. A basket of options will be provided to the farmers 

to choose the farm plan. Accordingly the technologies and inputs will be assessed besides credit, 

machineries and credit requirement.   

Further the stake holders like input dealers, fertilizer manufacturers, plant protection chemical companies, 

service providers like PWD, Electricity, credit institutions, insurance companies etc., will be informed 

about the farmer requirement for advanced planning and support.   

  

A Crop Monitoring System has been conceptualized which facilitate field monitoring during critical crop 

stages. Corrective measures if any needed it will be sent to the farmers through SMS/voice alerts. The 

yield will be assessed and informed to the market providers to initiate procurement process. Market 

Intelligence will also be provided to the farmers then and there to select profitable market for higher 

return.   

Scheme Benefits Tracking Module   

The benefits provided under State, Central and centrally sponsored programmes will be maintained in the 

AGRISNET portal. The information will be integrated to the individual farmer ID and will contain the 

detailed list of benefits and photographs showing disbursement of said benefits. For capital assets 

provision is being created for periodical monitoring and uploading photograph depicting the status of the 

asset. For technology oriented benefits the various stages of implementation along with its performance 

will be captured as image and uploaded. The list of beneficiaries under each scheme will be available to 

public view so as to maintain transparency in implementing the scheme. This system is being 

implemented in all the districts.   

To envisage timely information dissemination and farmer’s data updation an interactive voice response 

system through mobile has been developed on a collaborative mode with IITM-RTBI, Chennai. This will 

facilitate the farmers in updating their information in the web portal through voice interface. Further they 

are able to get the technological information available in the web portal through voice interface. Currently  

Agro Voice advisories through mobile phones are being given to all the Farmers of Tamil Nadu. These 

advisories consist of location/Crop specific whether Forecast, Technology information, scheme benefit 

details and Commodity wise market trends.   



55  

  

  

Online Hiring System of Farm Machineries   

Paucity of farm labourers is major issue hinders the Agricultural operations across the state. Hence the 

farmers largely depend on farm machineries which cannot be purchased by all of them. As a support to 

small and marginal farmers the Agricultural Engineering Department provides farm machineries on rental 

at a low tariff than the private outlets. Presently they approach physically for booking which drains time 

and money. So the Department of Agriculture has planned to provide an online booking system of farm 

machineries through the existing AGRISNET web portal.   

With this system, the farmer can plan well ahead about the requirement of farm machinery and book it 

online and can make payment online through a payment gateway. This helps the farmers from time and 

money exhaustion.   

  

  

Online Input Inventory Management System  

  

   

Linking Agricultural Extension Centres (AEC)   

A grassroots level office in the state provides Input and extension support to the farming community. 

Field functionaries in the AECs disseminate the technologies to the farmers for increasing food grain 

production. Currently, 379 Main Agricultural Extension Centers and 506 Sub Agricultural Extension 
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Centers totaling 885 Nos of AEC’s cater to the needs of farmers such as distribution of critical inputs like 

seeds, bio-fertilizers, micro nutrient mixture, bio-pesticides, agricultural implements like conoweeder, 

marker and plant protection equipments either at subsidy or full cost. The input inventories at AEC are 

manually maintained and the availability of critical inputs such as seeds during peak season could not be 

ascertained instantaneously to facilitate the farmers. Hence a system of e-billing has been introduced in 

all the Block Agricultural Extension Centers.   

All the billing information will be integrated with the beneficiary portal already developed and the 

information about the inputs/implements distributed through e-billing will be made available to the public 

to maintain transparency. This will facilitate the farmers to know the availability of critical inputs at AECs 

by accessing the AGRISNET web portal. Further it will enable the extension functionaries to mobilize 

and stock inputs at the AECs during peak cropping season.   

Electronic gadgets deployed for continuous Crop health monitorin   

  

Conclusion:   

  

According to Edger Dale (1969) the cone of learning experience which emphasized that highly effective 

extension education tool from the bottom of cone and enhancing the knowledge retention and recollection 

to the tune of 90 % after two weeks of exposure. Further, it explains from bottom to the tip of cone various 

extension approaches and tools. The reading materials like training module, newspaper, magazine and 

book shall provide 10 % knowledge retention. Keeping the emergence of Information and 

Communication Technology tools (ICT), it is right time it is enlisted various new media tools like web 

based, mobile based with different formats for farm technology transfer and capacity building initiatives. 

Now in the digital age, many modules and social network sites are offering educational tutorial for the 

benefit of school, college and professional students. On the part of Agricultural technology dissemination 

it is right time to use many tools simultaneously to educate the farmers on recent know-how prosperity.  
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